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Part 1: Introduction
Olink high-multiplex immunoassay panels provide an efficient and innovative tool for targeted human 
protein biomarker discovery, development and validation.

1. About this manual
This user manual provides you with the instructions needed for data processing when running Olink® 
Reveal, Olink® Explore HT, or Olink® Explore 3072/384 panels with a locally installed set up of software. 

NOTE:  The information in the NPX™ Map Software User Manual is believed to be accurate. 
However, the displayed screenshots may differ from actual user interface and should be 
considered as examples. 

1.1	 Intended use
NPX™ Map is a data analysis software that is designed for Olink Reveal, Olink Explore HT, and Olink Explore 
3072/384 platforms. It allows for importing data, validating data quality, and normalizing Olink data for 
subsequent statistical analysis.

NPX Map is intended for Research Use Only. Not for use in diagnostic procedures. 

All trademarks and copyrights contained in this material are the property of Olink® Proteomics AB unless 
otherwise stated. For questions, guidance, and support, contact Olink Support at support@olink.com.

1.2	 Intended target group
NPX Map is intended to be used by staff certified to run the Olink Reveal, Olink Explore HT or Olink Explore 
3072/384 platform. Quality control should be performed by trained users that determine whether data from 
a run can be approved for further analysis.

2. List of abbreviations
%CV Coefficient of Variance

NGS Next Generation Sequencing

PCR Polymerase Chain Reaction

PEA Proximity Extension Assay

QC Quality Control

SD Standard Deviation

NPX™ Map 
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3. Associated documentation

3.1	 Olink documentation
•	 NPX™ Map Preprocessing Technical Information, vx.x or later

•	 NPX™ Map CLI Technical information, vx.x or later

Olink Reveal manuals
•	 Olink® Reveal Overview User Manual 

•	 Olink® Reveal Laboratory Instructions

Olink® Explore HT manuals
•	 Olink® Explore HT Overview User Manual 

•	 Olink® Explore HT F.A.S.T. lab instructions

•	 Olink® Explore HT Mosquito lab instructions

•	 Olink® Explore HT Sequencing using NovaSeq 6000 S4 User Manual

•	 Olink® Explore HT Sequencing using NovaSeq X User Manual

Olink® Explore 384/3072 manuals 
•	 Olink® Explore Overview User Manual 

•	 Olink® Explore 384 User Manual 

•	 Olink® Explore 4 x 384 User Manual 

•	 Olink® Explore 3072 User Manual 

•	 Olink® Explore Sequencing using NextSeq 550 User Manual 

•	 Olink® Explore Sequencing using NextSeq 2000 User Manual 

•	 Olink® Explore Sequencing using NovaSeq 6000 User Manual 

•	 Olink® Explore 384/3072 Sequencing using NovaSeq X Plus User Manual

All relevant Olink documentation is available from the Olink website www.olink.com/downloads.

3.2	 Other documentation 
•	 Article & lot configuration sheet - delivered together with the analysis kit.

4. Technical support
For questions, guidance and support, please contact Olink Proteomics at support@olink.com.

NPX™ Map 
Part 1: Introduction 

3. Associated documentation & 4. Technical support

https://www.olink.com/resources-support/document-download-center/
mailto:support%40olink.com?subject=


6

5. Process

5.1	 Hardware and software requirements

5.1.1	 System requirements for NPX™ Map
Components Minimum Recommended

Operating System Windows® 10 or Windows® 11

Processor Intel® Core™ i5 Intel® Core™ i7 or higher

Memory 16 GB RAM 32 GB RAM or more

Disk Space 500 GB 500 GB

Display scale of computer 
screen

Scale 100 % * 
14'' screen

* The scale resolution might affect different functions and features in the NPX Map software, and different scale resolutions might be needed for different 
displays. Please, go to the computer settings to change to your preferred settings.

5.1.2	 System requirements for Preprocessing
Components Minimum Recommended

Operating System Linux Ubuntu 20.04 LTS or  
Linux Ubuntu 22.04 LTS

Other Linux administrative knowledge

5.1.3	 Requirements for analysis
Files and information needed for analysis:

•	 Count files in CSV format and run metadata in JSON format (NGS raw data preprocessed using 
ngs2counts) 

•	 Plate layout with sample names

•	 Data analysis reference ID number of reagents used (provided on the Lot configuration insert delivered 
with the kit)

NPX™ Map 
Part 1: Introduction 

5. Process
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5.2	 Preprocessing runs
Preprocessing is a necessary step in NPX Map analysis. The Next Generation Sequencing (NGS) output 
from the sequencing instrument is converted to counts files containing the number of reads for each Olink 
sequence and a run metadata file containing additional information which is necessary for importing the 
counts files into the analysis software NPX Map or NPX™ Map CLI. 

The preprocessing can be carried out in different ways:

One option is to use the dedicated preprocessing software. 

Preprocessing Counts 
Raw 

NGS data 

Alternatively, the files can be imported directly into the NPX Map. 

Preprocessing Counts

fastq files

NPX Map 
Launcher

For more information about the different preprocessing versions, refer to the NPX™ Map Preprocessing 
Technical information.

5.3	 CLI
QC and normalization of Olink Reveal, Olink Explore HT, and Olink Explore 3072/384 data can be 
performed either using the NPX Map CLI or the NPX Map Software, or using a combination of the two.

Input from 
Preprocessing 

Counts NPX Map Extended NPX file

Explore  
& Reveal
project

Output data

Plate Layout 
files

Analysis Report
Explore 

Calculation Module

Map CLI

Explore 
Calculation Module

NPX Map is a command-line interface (cli). The application is capable of performing normalization, Quality 
Control (QC) and CV computations on NGS data, and exporting the results on several supported formats. 

For more information, refer to the NPX™ Map CLI Technical Information.

NPX™ Map 
Part 1: Introduction 

5. Process
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Part 2: Technology description

6. Overview
Olink Reveal, Olink Explore HT, and Olink Explore contains a built-in quality control system using internal 
and external controls, which enables full control over the technical performance of assays and samples.

6.1	 Internal controls
Three internal controls are spiked into every sample for each panel and dilution. The internal controls are 
designed to monitor the quality of the assay’s performance, as well as the quality of individual samples:

Amplification control
Extension control

Incubation control

IMMUNO REACTION EXTENSION/LIBRARY AMPLIFICATION DETECTION
C T G A

C T T
G

GA
A A

A

A
T

C

T

T

C T T
G

GA
A A

A

C
T

G A A T
C

T

T

Incubation Control (Immuno Control) 
The Immuno Control is a non-human antigen measured with PEA. This control is included in the immuno 
reaction and monitors potential technical variation in all three steps of the reaction. 

Extension Control 
The Extension Control is an antibody coupled to a unique pair of DNA-tags. These DNA-tags are always in 
proximity so this control is expected to give a constant signal independent of the immuno reaction. This 
control monitors variation in the extension and amplification step.

Amplification Control 
The Amplification Control is a complete double-stranded DNA amplicon that does not require any proximity 
binding or extension step to generate a signal. This control monitors the amplification/sample indexing step.

The Extension Control is used to calculate the NPX, refer to Section 7.4 Normalization, and the other two are 
used in the Quality Control.

NPX™ Map 
Part 2: Technology description 

6. Overview



9

7. The QC workflow
Three internal controls are added to each sample to monitor the quality of assay performance, as well as the 
quality of individual samples:

• Incubation Control

• Extension Control

• Amplification Control

The Extension Control is used to calculate the NPX, refer to Section 7.4 Normalization, and the other two are 
used in Quality Control (described below).

Output:
Count

Output:
Count, ExtNPX, 

NPX_pc, NPX_int

FAIL

PASS/WARN

Systematic
Effects

Row/column
effect

Gradient
pattern

Plate QC

Sample QC

Block QC

Assay QC

Normalization

Plate 
Control

Intensity

NPX™ Map 
Part 2: Technology description 
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7.1	 Plate QC
The QC is performed directly on counts, on one block per 96 samples. The Plate QC are divided into three 
parts: Sample QC, Block QC, and Assay QC. For acceptance criteria, refer to Section 8. QC criteria. 

7.1.1	 Sample QC
Samples and external controls that fail Sample QC will not be considered for additional QC steps and not 
normalized. Only counts will be reported for those.

1. Low total number of counts per sample per block 
Too low total counts for a sample might indicate that the sample is missing or the index was not added 
to the sample. Each sample and external control should have a minimum number of counts in a block, 
otherwise they fail.

2.	 Low number of counts of internal controls per block 
Low counts in any of the internal controls might indicate a technical error in the workflow for the 
corresponding sample, for example a missing internal control. 

– Each external control should have a minimum number of counts for each of the internal controls, 
otherwise they fail. 

– Each sample should have a minimum number of counts for each of the internal controls, 
otherwise they fail or get a warning.

3.	 Deviation of counts in Plate Controls 
Deviation of internal control's counts from the expected ranges in Plate Controls might indicate different 
technical errors.

– A Plate Control fails if the fraction of counts of all internal controls to total counts in logarithmic 
scale, deviates positively or negatively from the reference values. The reference ranges are block 
specific and kit lot related.

4.	 Unexpected signal in Negative Controls 
Detection of high number of counts for many assays, relative to the counts of internal controls, in any 
Negative Controls might indicate that signals are from other sample types or not from pure buffer.

– A Negative Control fails if many assays get higher number of counts relative to the counts of 
internal controls.

5. Deviation of incubation control ratio per sample per block 
The relative count levels of incubation control to other internal controls (ratio in logarithmic scale) should 
be consistent across the plate. Any sample where these ratios deviate from the expectation by an amount 
larger than a reference value indicates a technical error in the workflow.

– The expected incubation control ratios are given by the median of the plate controls and sample 
controls per plate per block.

– An external control fails if the incubation control ratio is much lower than the expectation.

– A sample gets a warning if the incubation control ratio is much lower than the expectation.

7.1.2	 Block QC
Block QC is to quality control whether a block-plate is affected by technical errors. This step is based on the 
number of Plate and Negative Controls that pass Sample QC. A failed block is recommended to be rerun. 

1. Based on Plate Controls:

– A block-plate fails if <50% of Plate Controls pass the Sample QC (a minimum of 3 Plate Controls 
is required to pass the block-plate).

2.	 Based on Negative Controls:

– A block-plate fails if none of the Negative Control pass the Sample QC.

NPX™ Map 
Part 2: Technology description 
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7.1.3	 Assay QC
Detection of high number of counts for any assay, relative to the median count of three internal controls in 
all the Negative control is considered as unexpected signal. This step is performed on Negative Controls 
that pass Sample QC. An assay gets a QC warning if it gets high number of counts relative to the median 
counts of three internal controls in all Negative controls,

7.2	 Systematic effect detection
Systematic effects are defined as a systematic  pattern on a plate caused by a deviation in the workflow 
such as instrument failure or human error. A pattern corresponds to a particular type of failure. Detection of 
systematic effects is complementary to the Plate QC and is performed on NPX. All samples and data-points 
(passed, failed, and warned) are included in the computation. 

Systematic effects are categorized into patterns that impact the full plate or impacting a row or/and column. 
To detect the patterns, three main criteria are considered: 

• The frequency of assays representing the effect

• The intensity of the effect on NPX deviation

• Number of samples showing the effect 

A pattern is detected per assay/block/plate unit. If enough assays (internal controls are not included) are 
affected, the block will get a systematic effects warning corresponding to that effect in NPX Map. For more 
information, refer to Section 15.3 Quality Control Summary. Systematic effects may be due to either non-
randomized plate design or technical errors and should be investigated further when warned. 

7.2.1	 Types of systematic effects
• Row

• Column

• Four_column

• Alternating_column

• Row_gradient

• Column_Gradient

• Diagonal_Gradient

7.3	 Summary notes for exported data
• Data related to all assays, including the internal controls, will be presented in the output NPX file. 

• Data related to all samples, including the external controls, will be presented in the output NPX file.

• Data related to any failed sample or block that do not pass QC criteria will not be normalized and 
therefore no NPX will be computed. Counts are reported for the failed data-points in the NPX file. 

• Any data-points with a QC warning should be used with caution. 

For any more information about Plate QC and systematic effects, please contact support@olink.com.

NPX™ Map 
Part 2: Technology description 
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7.4	 Normalization
The two between-plate-normalization methods are called Plate Control (PC) and Intensity normalization. 
They both adjust each assay per plate to a median, but they differ in how these medians are calculated. An 
important concept when selecting normalization procedure is randomization, which in this context applies 
to the sample placement across the plates. For details, refer to the Randomization FAQ on the Olink website.

Plate Control normalization is performed by default. Intensity normalization should be selected for all Olink 
Reveal, Olink Explore HT, and Olink Explore 3072/384 projects where samples are randomized. Contact 
support for study design assistance and choosing the appropriate normalization type. 

7.4.1	 Converting counts to NPX
The Olink Reveal, Olink Explore HT, and Olink Explore 3072/384 system’s raw data output is counts, where 
each combination of assay and sample is given an integer value based on number of copies detected. These 
raw data counts are converted into NPX values for use in the continued analysis.

NPX generation 
The NPX values are calculated in two main steps. First, the assay counts of a sample are divided with the 
Extension Control for that sample and block, and a log2 transformation is applied (1). The resulting scale 
has increasing values with increasing concentration for each assay. 

The second step is either Plate Control normalization (2a) or Intensity normalization (2b). Plate Control 
normalization subtracs the median of the Plate Controls. Intensity normalization subtracs the median of all 
samples (excluding the control strip).

Steps in the NPX generation described in equation form, where i refers to a specific assay, j refers to a 
sample, and ExtNPX defines an extension normalized NPX value. 

1. ExtNPX_i,j = log2(counts(sample_j,Assay_i)/counts(ExtCtrl_j))

– Relate counts to known standard (Extension Control).

– For all assays and all samples, including Negative Controls, Plate Controls, and Sample Controls.

– Log2 transformation gives more normally distributed data.

2a. NPX_i,j = ExtNPX_i,j - median(ExtNPX(Plate Controls_i))

– Normalize by median of Plate Controls.

– For each assay, per plate.

2b. NPX_i,j = ExtNPX_i,j – median(ExtNPX(Samples_i))

– Normalize by median of samples (excluding control strip). 

– For each assay, per plate.

7.4.2	 CV calculation
To evaluate the reproducibility and repeatability of data related to each plate in the project, and to assess 
the within- and between-plate variation in the project, two types of CV are computed for each of the pre-
selected assays: within plate (intra CV) and between plates (inter CV) in Sample Controls. For the inter CV 
calculation, the mean of Sample Controls is used to represent the plate before CV calculation.

In each block, pre-selected assays with good performance in Olink Sample Controls are used so that any 
deviating CV actually indicates a potential technical issue within the workflow. The CV is calculated for NPX 
of those selected assays (i), using the assumption of a log-normal distribution, in Sample Controls using 
the formula below. The CV is part of the UI assessing run quality, and is presented in a CV Table showing 
average CV:s over the blocks

CVi = 100 √( e
Slni2 - 1), where Slni = ln(2) × SDisk

NPX™ Map 
Part 2: Technology description 

7. The QC workflow
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8. QC criteria
Criteria FAIL

NPX is not calculated, exclude from 

statistical analysis

WARN

NPX is calculated, assess further, use 

data with caution

Sample QC

Total counts per sample < 10 000 N/A

Incubation control counts per sample  < 150 < 500

Extension control counts per sample < 150 < 1000

Amplification control counts per sample  < 150 < 500

Internal control count fractions  
per sample

N/A • If Log2 of incubation-to-
amplification control count ratio 
< -3.5 and

• if log2 of incubation-to-extension 
control count ratio 
< -3.5 and

• if the absolute value of log2 of 
extension-to-amplification control 
count ratio >3.5.

External Control QC  

Total counts per sample < 10 000 N/A

Incubation control counts per sample < 500 N/A

Extension control counts per sample < 1000 N/A

Amplification control counts per sample < 500 N/A

Plate control internal control counts 
relative to assay counts

< or > internal control reference range 
to assay counts

N/A

Negative Control internal control counts 
relative to assay counts

Negative control fails  N/A

Internal control count fractions  
per sample

Log2 of incubation-to-amplification 
control count ratio < -3.5

N/A

Log2 of incubation-to-extension control 
count ratio < -3.5

N/A

The absolute value of log2 of extension-
to-amplification control count ratio >3.5

N/A

Block QC

Plate Controls passing external sample 
QC

For Olink Explore HT: 
< 50% (minimum 3 Plate Controls must 
pass QC)

N/A

For Olink Reveal: 
< 50% (minimum 3 Plate Controls must 
pass QC)

N/A

For Olink Explore 3072/384:

All 3 Plate Controls must pass QC.

N/A

Negative Controls passing external 
sample QC

< 1 N/A

Systematic effect (NPX) N/A >10% of assays 

Systematic effect identified

Assay QC

Assay count relative to internal control 
count in negative control

N/A Assay count ≥ median of all internal 
control count in all negative controls.

If a run fails to meet the acceptance criteria, or the QC is not accurate, please contact support@olink.com.

NPX™ Map 
Part 2: Technology description 
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Part 3: Operation

9. Introduction

This section describes how you analyze data step-by-step in NPX Map. The following steps are included in 
the standard operating workflow:

1. Preprocess data

2.	 Upload Panel Data Archive

3.	 Create a new project or open an existing project

4.	 Import NGS run data

5.	 Perform quality control

6.	 Export data files and Analysis Report

7.	 Finalize the project

NPX™ Map 
Part 3: Operation 

9. Introduction
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10. Operating workflow

10.1	 Preprocess data
It is possible to add one or more FASTQ or Ultima runs in NPX Map. 

1. Click on Preprocess data. 

2.	 Click on the Settings menu in the upper right corner to configure a new sequencing instrument 

NPX™ Map 
Part 3: Operation 

10. Operating workflow
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3. Fill in Instrument ID. Select Instrument Type from the drop-down menu. Click Add.
The Instrument ID is used for traceability and will be present in downstream data. It does not necessarily 
have to be the correct ID if that information is not known. 
Make sure to select the correct Instrument Type. This affects how the software processes the FASTQ files. 
If you're unsure which Instrument Type to select, please ask your service provider which instrument was 
used for the sequencing. 

4.	 The added instrument(s) are listed. When finnished, click Save. 

NPX™ Map 
Part 3: Operation 

10. Operating workflow
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NPX™ Map 
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10. Operating workflow

10.1.1 Process FASTQ data
The FASTQ file is a text file that contains biological sequence and its corresponding quality 
scores.

Click New FASTQ Run.  

Import the compressed FASTQ files and select an output folder to save the run. Individual compressed 
FASTQ files can only be imported by dragging and dropping them onto the field for FASTQ files. Folders 
containing compressed FASTQ files can be imported with the file picker or by dragging and dropping the 
files onto the field.  
The experiment name field is optional. If set it will appear as metadata for the processed run. Pick the 
product type used in the run. Fill in the run identifier field. The run identifier field is mandatory to help 
identify the processed run. It does not have to be the correct ID if that information is not known.  
When all fields are complete, click Run and the processing of the data will start. 
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It is not possible to leave the Process FASTQ data view while the uploaded run is processed. The FASTQ 
batch jobs are listed in the Process FASTQ data main window.  
Completed batch jobs are marked as either success or failure. Click on a batch job to view detailed 
information.  
Click on the Open output folder to open the output folder for the selected batch job. 

Click Return to main menu to return to the start page.
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10.1.2 Process Ultima data
Click New Ultima Run.  

. 

Click Standard or Merge to select workflow type. Use the standard workflow when a single wafer has been 
used for sequencing a pooled library. Use the merge workflow when two wafers have been used for 
sequencing the same libraries in parallel. 



20

Standard workflow
1. Import your files:

1.a.	 Click the Select Ultima Run Folder file picker.

1.b.	 Or drag and drop the files onto the Select Ultima Run Folder field. 

2.	 Select the output folder to save the run.

3.	 Select instrument.

4.	 Click Run and the processing of the data will start. 

NPX™ Map 
Part 3: Operation 

10. Introduction
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Merge workflow 
1.	 Import folder one:

1.a.	 Click the Select Ultima Run Folder file picker.

1.b.	 Or drag and drop the files onto the Select Ultima Run Folder field.  

2.	 Import folder two by repeating step 1.

3.	 Select the output folder to save the run.

4.	 Select instrument.

5.	 Click Run and the processing of the data will start. 
 

NPX™ Map 
Part 3: Operation 

10. Operating workflow
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Completed batch jobs are marked as either success or failure.  
Click on the Open output folder to open the output folder for the selected batch job.

 

Click Return to main menu to return to the start page.

NPX™ Map 
Part 3: Operation 

10. Introduction
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10.2	 Upload Panel Data Archive
Before creating a project, a compatible panel archive must be imported into the NPX Map.

The following steps must be repeated when new panel versions are needed and been downloaded from the 
Olink web page or been provided by Olink.

1.	 On the start page, click Panel Data Archive. 

2.	 The Panel Data Archive view shows latest version and minimum compatible version. 
Click Upload archive. 

NPX™ Map 
Part 3: Operation 

10. Operating workflow
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3.	 Browse for files to upload. Click Open. 
The uploaded panel data files will be listed. Click Done to get back to the start page. 

NPX™ Map 
Part 3: Operation 

10. Introduction



25

10.3	 Create a new project or open an existing project

10.3.1	 Create a new project

NOTE:  Some of the views differ between products.

1.	 Start NPX Map and click on Create a new project. 

2.	 Select Project Type and enter Project name and Sample matrix (optional).  

3.	 Click Data Analysis Reference IDs.

NPX™ Map 
Part 3: Operation 

10. Operating workflow
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4.	 Select Data Analysis Reference IDs for the blocks/panels in the product from the drop-down menu. 

 Olink Explore 3072/384  Olink Explore HT  Olink Reveal

 

5.	 Click Import Data. 
Clicking CreateProject will create a project without plate layouts and NGS runs. They can be imported 
later, from the Modify Project Data menu. Refer to Section 14.2 Modify Project Data menu.

6.	 Import plate layouts and NGS run folder.  
It is not possible to import zipped NGS run folders. However, they can be imported later, from the 
Modify Project Data menu. Refer to Section 14.2 Modify Project Data menu. 
It is possible to create a project without plate layouts and NGS runs by clicking Create project. 
It is not possible to create a project when only either plate layout or NGS run folder is uploaded. 

NPX™ Map 
Part 3: Operation 

10. Introduction
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7.	 When the files are uploaded, click Select NGS Runs. 

8.	 Import NGS run. 

 Olink Explore 3072/384  Olink Explore HT  Olink Reveal

Click Create Project. 
The project is created and the Project view is displayed.

NPX™ Map 
Part 3: Operation 

11. Export result files
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10.3.2	 Open an existing project
1.	 Click on Open an existing project.

2.	 Browse for a project to open. 

3.	 Click Open or open an existing project from the Recent Projects list.

It is possible to migrate an old Olink Explore 3072/384 project using this function. Refer to Section 12. 
Migration of Olink® Explore 3072/384 projects for more information.

NPX™ Map 
Part 3: Operation 

11. Export result files
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10.4	 Save project
1.	 Go to the Project Actions menu -> Save Project.

2.	 Browse for preferred folder to save the project.*

3.	 Click Save.

* In order to reduce the risk of file corruption due to potential limitations in network connectivity while using a VPN, it is recommended  
to save projects locally. By working directly from local storage, interruptions can be minimized and it can be ensured that the progress is  
consistently saved. Once the project work is complete, it can be uploaded or synced to a network location after disconnecting from the  
VPN or when network stability improves.

10.5	 Perform quality control
Refer to Section 15. Views for instructions on how to use the different views to perform quality control.

10.6	 Export data and Analysis Report
Several types of files can be exported from NPX Map: NPX files, Extended NPX files, Analysis Reports, and 
Plate Layout Template files. For more information about the files and file formats, refer to Section 11. Export 
result files.

For smaller projects, CSV format is available.

To export the file, go to the Modify Project Data -> Export, and select preferred file type to export.

NPX™ Map 
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Before an Analysis Report an be exported, the Analysis Report input form must be entered.

1.	 Go to Modify Project Data -> Analysis Report input. 

2.	 Fill in the fields and click either Save without exporting or Save & Export.

10.6.1	 Download a Plate Layout Template file
To download a Plate Layout Template file, go to Modify Project Data -> Plate Layout Template, and select product. All 
templates for all products can be downloaded as a CSV file.
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10.7	 Finalize a project

Before a project can be finalized, it need to be sent for review.

1.	 Save the project.

2.	 Go to Modify Project Data -> Set Project State -> Send to Review. 
The project is set to status Review, and no changes can be done. To cancel the review, go to  
Modify Project Data -> Set Project State -> Reopen.

3.	 When the review is done, Modify Project Data -> Set Project State ->Finalize. 
The project cannot be reopened, and no more changes can be made to the project.

NPX™ Map 
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11. Export result files

11.1	 NPX file
The NPX file is a Parquet or CSV-file that can be generated from NPX Map. It contains the following 
information about the project in table format:

Column Description Type Typical value

SampleID The annotated sample ID String

Sample Type Type of sample String PLATE_CONTROL, NEGATIVE_
CONTROL, CONTROL, SAMPLE

WellID Id for well String Capital letter A÷H followed by 
number 1÷12

PlateID Name of the plate the sample was run on String

DataAnalysisRefID Reference ID for data analysis String

OlinkID OlinkID for assay String

UniProt UniProt ID for assay String

Assay Gene name for assay String

AssayType Type of assay String Amp_ctrl, inc_ctrl, ext_ctrl

Panel Panel name String Reveal

Block Name of  the block the sample was run on String 1, 2, 3, 4, 5, 6, 7, or 8

Count The total number of counts Integer  Greater than or equal to 1

ExtNPX Intermediate value between count and NPX: log2 of the 
ratio between data-point Count value and the count for 
the Extension Control assay for the same sample.

Double -1.94701

NPX NPX value Double

Normalization Type of normalization used in project String  Plate control, Intensity or 
EXCLUDED

PCNormalizedNPX NPX value displayed if plate control normalization has 
been chosen.

Double 1.735509

AssayQC Overall QC status for an assay String NA, PASS, WARN

SampleQC Overall QC status for a sample in a block String NA, PASS, WARN, FAIL

MapVersion Software version of the module in NPX Map used for 
panel calculations and normalization

String

NPX™ Map 
Part 3: Operation 

11. Export result files



33

11.2	 Extended NPX file
The Extended NPX file is a Parquet or CSV-file generated by the NPX Map CLI and NPX Map. It contains all 
the columns in the NPX file, plus the set of additional columns listed below. 

•	 IntraCV​

•	 InterCV​

•	 SampleBlockQCWarn​

•	 SampleBlockQCFail​

•	 BlockQCFail​

•	 AssayQCWarn​

For more information, refer to the NPX™ Map CLI Technical Information.

11.3	 Analysis Report
The analysis report is a pdf file generated by the NPX Map CLI and NPX Map. It summarizes the quality 
analysis of the project. It contains basic information and descriptions of the project. It also contains a 
summary of the Quality control including sample passed QC.

The Analysis Report contains the following:

•	 Project information

	– Sample matrix

	– Project specific comments

•	 Quality control

	– QC summary

•	 Data output

•	 Software version information

•	 Appendix - A table including the following columns

	– Olink Panel

	– Block

	– UniProt

	– Assay Olink ID

NPX™ Map 
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11.4	 Parquet file format
NPX data is exported from NPX Map in either CSV or Parquet file format. Parquet is a free open source file 
format built to handle columnar storage data.

Parquet files provide several advantages compared to CSV, such as

•	 Much more efficient data compression with enhanced performance to handle complex data in bulk.

•	 Improved data integrity through binary encoding (files can't be opened and changed using a text 
editor).

The binary encoding also means the file cannot be opened in Microsoft® Excel. If required, Parquet files can 
be exported to CSV format. The CSV format is available for projects with approximately 1 million datapoints.

Parquet is available in multiple languages including Java, C++, Python, C# etc. You can find further details 
at these locations

•	 https://parquet.apache.org/docs/

•	 https://en.wikipedia.org/wiki/Apache_Parquet

11.4.1	 How to interact with a Parquet file
There are many different solutions to interact with a Parquet file, for example DBeaver. Olink do not 
recommend any specific solution.

Installing DBeaver
1.	 Download DBeaver for free from the Microsoft® Store by clicking on the start menu and type "Microsoft 

store". 

2.	 Type "DBeaver" in the search field, and press Enter. 

NPX™ Map 
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3.	 Once DBeaver is installed, setup a new database connection. 

4.	 Choose DuckDB and hit the Next button. 

5.	 Type ":memory:" in the Path input field. 

6.	 Click the gray arrow. 

NPX™ Map 
Part 3: Operation

13. Different projects or sample matrices on the same plate



36

7.	 Download driver files. 

8.	 Open a new script window.  

9.	 Type a PostgreSQL query such as  
SELECT * FROM 'C:/npxfile.parquet'.  
Make sure that the path in double quotes refers to the NPX file you want to query.

10.	Click the "Execute SQL query" button 

11.	 View the result. 

Export data to a CSV file
1.	 Click Export data. 

2.	 Highlight CSV and click Next. 
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3.	 Click Next. 

4.	 Click Next. 

5.	 Set the "Directory" field to a location on your hard drive.

6.	 Click Next. 

7.	 Click Proceed. 

11.4.2	 Quick-check parquet-viewer
To quick-check the parquet, perform the following steps:

1.	 Download ParquetViewer from the GitHub wepage: https://github.com/mukunku/ParquetViewer/
releases.

2.	 Install ParquetViewer and open it.

https://github.com/mukunku/ParquetViewer/releases
https://github.com/mukunku/ParquetViewer/releases
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3.	 Drag and drop the parquet file to the application window.

4.	 Use the query input field to filter out desired datapoints, or use the Record Offset field to jump in the 
file.

5.	 For more information or help, refer to the GitHub homepage: https://github.com/mukunku/
ParquetViewer/wiki/Basics.

https://github.com/mukunku/ParquetViewer/wiki/Basics
https://github.com/mukunku/ParquetViewer/wiki/Basics
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12. Migration of Olink® Explore 
3072/384 projects
Olink Explore 3072/384 projects created in NPX Explore can be migrated into NPX Map to utilize the new 
QC procedure and features.

12.1	 Migrate a project
1.	 Click on Open an existing project.

2.	 Browse for project to migrate 

3.	 Click Open.

12.2	 Migration information
Not all data will be copied over into the migrated project such as data specific to the old QC and 
normalization. Some project data fields may also be trimmed due to newer constraint requirements on 
length and content. Data such as counts, plate layouts and imported run units are imported as they were in 
the old project. The migration of the project leaves the old project and files intact and can be opened in the 
old software as usual.
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13. Different projects or sample 
matrices on the same plate
When running  different projects or sample matrices on one plate, an extended plate layout must be created.

1.	 Manually create a single plate layout file with two extra columns: Project Name and Sample Matrix, 
according to the following order:

well_ID; sample_ID; sample_type; sample_matrix; project

2.	 Create one project per project/sample matrix,  according to 10.3 Create a new project or open an existing 
project. 

3.	 Upload the manually created plate layout in both projects. The following view will be displayed: 

4.	 Fill in new Plate ID and select Project and Sample Matrix.

5.	 Click Apply.

6.	 Continue according to 10.3 Create a new project or open an existing project. 
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Part 4: User Interface

14. General

2

1
4

6

5

7

3

No Part Description

1 Minimize View menu Minimize or maximize the View menu.

2 Plate selection Select plate and panel to display (For Olink Reveal and Olink 3072/384)

Select plate and block to display (For Olink Explore HT)

3 View menu For information about the different views, refer to Section 15. Views

4 Modify Project Data menu Menu for modifying the project data, such as setting reference IDs, 
Normalization etc. Refer to Section 14.2 Modify Project Data menu

5 Project Actions menu Menu for handling the project, such as Open Project, Save Project, Clone 
Project etc. Refer to Section 14.3 Project Actions menu.

6 Main view Shows the selected view from the View menu. 

7 Normalization Shows selected normalization method. To change normalization method, 
refer to Section 14.2 Modify Project Data menu.

NPX™ Map  
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14.1	 Plate Selection

Use this menu to select which plate and panel/block to view. Click the small arrow to show or hide the list of 
blocks. Select a specific block by clicking its name. 

NOTE:  Olink Reveal consists of only one panel, called Reveal.

14.2	 Modify Project Data menu

Menu Expansion Description

Import Plate Layouts

Import NGS Run Folder

Import Zipped NGS Run File

Import Plate layouts, NGS run folders and zipped 
NGS run files to the current project.

Export NPX File

Extended NPX File

Analysis Report

Export the data files. Refer to Section 10.6 Export 
data and Analysis Report

Plate Layout Template Explore 3072 
Explore HT – Index Plate A 
Explore HT – Index Plate B 
Reveal

Export a Plate Layout Template file. Refer to Section 
10.6.1 Download a Plate Layout Template file

Set Reference IDs ÷ Set reference IDs for the current project.

Normalization Plate Control

Intensity

Change normalization method for the project. Refer 
to Section 7.4 Normalization.

Recalculate Project ÷ Recalculate the project.

Analysis Report Input ÷ Enter information to the Analysis Report. Refer to 
Section 11.3 Analysis Report.

Set Project State Send to Review

Reopen

Finalize

Final stages for the project. Refer to Section 10.7 
Finalize a project.

14.3	 Project Actions menu

Menu Description

New Project Create a new project. Refer to Section 10.3 Create a new project or open an existing 
project.

Open Project Open a saved project. 

Save Project Save the current project. Refer to Section 10.4 Save project.

Clone Project Create a clone of the current project.

NPX™ Map  
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Menu Description

Close Project Close the current project.

Help This option opens the Documents page. To find the manual, type its name in the 
search box.

About & Licensing Show information about the software and licensing information.

Quit NPX™ Map Close the software.
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14.4	 Shortcuts

14.4.1	 Keybord shortcuts for switching between blocks/panels
The block navigation allows you to move from the first block/panel (Block 1/Cardiometabolic) to the last 
block/panel (Block 8/Oncology II) in the plate. If there are no next or previous blocks/panels, the shortcut 
does nothing. Excluded blocks/panels are included in the navigation.

•	 Ctrl + .      Move to next 

•	 Ctrl + ,       Move to previous

14.4.2	 Keybord shortcuts for switching between plates
The plate navigation allows you to move between plates. If there are no next or previous plates, the shortcut 
does nothing. Plates without data are excluded from the navigation.

•	 Ctrl + shift + .      Move to next plate      

•	 Ctrl + shift + ,       Move to previous plate

NPX™ Map  
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15. Views 
Project
Overview of the project, showing project details, comment log etc.

Run Unit Details 
The Run Unit Details shows information about the selected plate and panel/block. 

Quality Control Summary
The Quality Control Summary tab displays a summary of the QC criteria per block.

Supplementary Tables 
Contains tables that display sample IDs and assays that failed or warned based on any of the 
QC criteria. It helps identify the possible root cause for sample and block failure.  

CV Information 
Assess the precision of the data based on a group of pre-selected assays across different 
blocks on the Sample Controls. 

Plate Variation  
Display differences in sample distributions within and between plates.

Plate Data 
Shows the values of NPX and Counts for internal controls and assays for each sample per 
block. Assess if there are patterns in the plate representing a possible technical error. 

Correalation Assays (Only for Olink Explore 3072/384) 
Assess the correlations of each overlapping assay between blocks. Skewed data correlation in 
any of the plots can indicate the technical error in the lab workflow.

Heat Map 
Search for extreme outlier samples and systematic patterns that reflect a possible technical 
error.

Sample QC Overview (Only for Olink Explore HT and Olink Explore 3072/384) 
View and evaluate patterns of failed/warned samples within and across the blocks in each 
plate and view the criteria that have resulted in failure or warning status.

History
Shows the changes made in the project.

15.1	 Project
General:
The Project view shows the following information about the project:

•	 Project Details

•	 Comment Log 

•	 Data Analysis Reference IDs

•	 Add Comments

NPX™ Map  
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Useful for:
Add comments regarding the QC. The comments will not be included in the Analysis Report.

Functions:
•	 Change Project Name or Sample Matrix by clicking on Edit and write in the field. Click Done.

•	 Add comments for the project by writing in the Add Comment field. The comment will be shown in the 
Comment Log field. The comments will be included in the Analysis Report.

NPX™ Map  
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15.2	 Run Unit Details
General:

The Run Unit Details shows information about the selected plate and panel. 

Useful for:

•	 Reviewing failed blocks/samples.

•	 Finding systematic effects.

•	 Include, exclude, or delete plate.

Functions:

•	 For each plate, the following information is displayed:

	– Preprocessing Date 
The date when instrument data for this run unit was preprocessed.

	– Run Identifier 
The unique identifier of the instrument run this run unit belonged to.

	– Library 
The assay library of this run unit.

	– Run name 
The name of the instrument run containing this run unit.

	– Block (Only for Olink Explore HT) 
The block of this run unit.

	– Panel (Only for Olink Reveal and Olink Explore 3072/384) 
The panel of this run unit.

	– Data Analysis Reference ID 
The specific Data Analysis Reference ID this run unit was calculated with.

NPX™ Map  
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	– Index Plate 
The index range of the samples in this run unit.

	– Instrument ID 
The ID of the instrument that performed the run.

	– Count File 
The name of the file that contained the counts data for this run unit.

	– Negative Control 
The status of the negative controls in this unit; "Fail" if any negative control is failed, otherwise "Pass"

	– Plate Control 
The status of the plate controls in this unit; "Fail" if any plate control is failed, otherwise "Pass"

	– Flowcell Type 
The type of flow cell that was used in the corresponding run (only applicable to Illumina 
instruments).

	– Flowcell Side 
The side of the instrument that was used in the corresponding run (only applicable to Illumina 
instruments)

	– Preprocessing software 
The name of the software and version that was used to preprocess instrument data.

•	 Select Manual Assessment: None/Pending/Good/Bad.

•	 Set Run Status to Include run/Exclude run or Rerun needed.

•	 Use the drop-down menues to do the following changes:

	– Select Plate

	– Annotate a Rerun of

	– Set Primary error cause

	– Set Step fail reason

	– Set Include reason

•	  Add comments in the comment field. Comments will not be included in the Analysis Report.

NOTE:  The counts presented in this view are expected to differ from the sum of counts from 
individual data points presented in the NPX File. The counts presented in the NPX File should be 
used for downstream analysis.

15.3	 Quality Control Summary
General:

The Quality Control Summary view displays a summary of the QC criteria per plate.

Useful for:
•	 Reviewing status of the selected block.

•	 Finding systematic effects.

•	 Getting a quick overview of whether the total counts for the block (Explore HT) or panel (Explore 
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3072/384 and Olink Reveal) significantly deviate between plates, which could indicate a lab preparation 
or sequencing issue.

Functions:

•	 For each plate, the following information is displayed:

	– Plate ID

	– Panel (Only for Olink Reveal and Olink Explore 3072/384)

	– Block (Only for Olink Explore HT)

	– Failed samples

	– Warned samples

	– Failed PC

	– Failed NC

	– Failed SC

	– Warned assays

	– Block QC

	– Systematic effects

	– Counts*

	– Run status

•	 Use the actions drop-down menu to include, exclude or remove the selected items. Click Apply.

NOTE:  The counts presented in this view are expected to differ from the sum of counts from 
individual data points presented in the NPX File. The counts presented in the NPX File should be 
used for downstream analysis.

15.4	 Supplementary Tables
General:

The Supplementary Tables view contains five tables displaying samples that have failed or have warnings 
based on QC criteria. All data for one sample source plate is displayed at a time.

Only tables that contain data will be displayed.
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Useful for:

•	 Reviewing flags of all samples and assays in tables, divided into five different flag reasons:

	– Assay warnings

	– Samples which are failed due to low total counts

	– Samples which are failed due to low internal control counts

	– Deviating plate controls

	– Failed negative controls

Functions:

•	 The following information will be displayed in the different tables:

Assay warnings Samples which are 
failed due to low total 
counts

Samples which are 
failed due to low 
internal control counts

Deviating Plate 
Controls

Failed Negative 
Controls

•	 Plate ID

•	 Panel

•	 Block*

•	 Assay

•	 Olink ID

•	 Plate ID

•	 Panel

•	 Block*

•	 Well ID

•	 Sample ID

•	 Sample Type

•	 Plate ID

•	 Panel

•	 Block*

•	 Well ID

•	 Sample ID

•	 Sample Type

•	 Total Count

•	 Plate ID

•	 Panel

•	 Block*

•	 Well ID

•	 Sample ID

•	 Amplification

•	 Extension

•	 Incubation

•	 Plate ID

•	 Panel

•	 Block*

•	 Well ID

•	 Sample ID

•	 Sample Type

* Block only for Olink Explore HT and Olink Explore 3072/384.

•	 The Failed Negative Controls table includes empty wells that show too high signal.
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15.5	 CV Information
General:

The CV Information view shows the CV information, one row per block. CV is calculated based on the data 
points of Sample Controls that passed the QC criteria. 

Useful for:

•	 Getting an overview of the CV values per block, and which blocks that have missing CV values.

Functions:

•	 The following information will be displayed:

	– Panel (Only for Olink Reveal)

	– Block (Only for Olink Explore HT and Olink Explore 3072/384)

	– Plate

	– Mean CV value

•	 The CV Table shows the following information:

	– Intra-Assay %CV Mean

	– Inter-Assay % CV Mean

	– Number of plates with missing intra CV mean

Reference values: 
The reported %CV is the mean %CV over all pre-selected assays. A high %CV does not fail a run 
automatically but could indicate a technical issue or poor sample randomization and can be a cause for 
further investigation. 

•	 Inter %CV: < 25%  

•	 Intra %CV: < 15% 
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15.6	 Plate Variation
General:

The Plate Variation tab displays a box plot with NPX values from the Sample wells. Failed run units will be 
left empty.

Useful for:

•	 Detecting systematic variance in total intensity between plates.

Functions:

•	 To switch between correlation assays, use the Assay drop-down list or enter a specific assay name in the 
text box

•	 Select All in the Assay drop-down list to view the summary of all assays and controls for each sample.

•	 Select Block to view (Only for Olink Explore 3072/384)
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15.7	 Plate Data
General:

The Plate Data view shows heatmaps of one unit a time, including the internal controls: extension control, 
incubation control and amplification control. Empty wells show counts but not NPX.

For Olink Explore 3072/384, all blocks are shown at the same time.

Useful for:

•	 Inspecting counts and NPX across a plate for each assay.

•	 Discovering systematic patterns.

•	 Discovering plates swap based on data pattern across the plate (If the plate has any empty well).

Functions:

•	 To switch between assays, use the Assay drop-down list or enter a specific assay name in the text box. 

•	 Change value type by selecting either NPX or Counts.

•	 Use the Systematic effect filter to select type of systematic effect, or swith it off. (Only available 
systematic effects types are shown in the drop-down menu)
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15.8	 Correlation Assays (Only for Olink® Explore 3072/384)
General: 

The Correlation Assays tab shows correlation assays that overlaps across the blocks per sample plate. 

•	 A plate is chosen: all included run units are shown. 

•	 An excluded run unit is chosen: the text "No data display" is shown. 

•	 Failed samples: no data points will be shown. 

•	 Failed blocks: an empty graph with red text "Panel QC failed [NPX] "will be shown.

Useful for:

•	 Getting an overview of correlation assays.

Functions:

•	 To switch between assays, use the Assay drop-down list or enter a specific assay name in the text box.
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15.9	 Heat Map
General: 

The Heat map view contains a color-coded view for all assays and samples in the chosen block. The assays 
are displayed in the horizontal direction and samples in vertical direction. Empty wells show counts but not 
NPX. A failed block is marked by a red banner.

The heatmap displays deviations from the plate median for the selected assay using the colors blue and red: 

•	 Blue: values below median

•	 Red: values above median. 

Useful for:

•	 Finding systematic patterns.

•	 Finding outlier samples for specific assays.

Functions:

•	 Select sample type to display. (All External Controls, Sample, Plate Control, Negative Control, Sample 
Control) 

•	 Switch Sort order between row and column.

•	 Change Value type by selecting either NPX or Counts.

•	 Select Block to view (Only for Olink Explore 3072/384)

•	 Use the Systematic effect filter to select type of systematic effect, or swith it off. (Only available 

systematic effects types are shown in the drop-down menu)

•	 Hover over a well to show:

	– Assay

	– Sample ID

	– Well ID

	– Plate ID

	– Deviation from assay median

	– Value

	– Sample QC

•	 Zoom functions

	– Zoom in and out by scrolling the mouse wheel..



56

	– Zoom to fit: Adjusts the heat map to fit in the view.

	– Zoom to fit height: Adjusts the heat map to fit the vertical space of the view.

	– Bottom align: Aligns the heat map to the bottom of the view.

•	 Move the map to see different assays by clicking and holding the left mouse button and drag the heat 
map.
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15.10	Sample QC Overview (Only for Olink® Explore HT)
General:
The Sample QC Overview displays a color-coded heatmap showing status for each sample in all blocks.

•	 Blue: Pass

•	 Red: Fail

•	 Yellow: Warning

If a sample has both a fail and a warning, it is shown as fail.

Useful for:

•	 Finding systematic errors across different blocks.

Functions:

•	 Switch Sort order between row and column.

•	 Hover over the cells provides information on:

	– Sample ID

	– Block

	– Well ID

	– For failed and warned samples: reason for failure or warning.

15.11	History
General:

The History view displays all events for the current project.
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Useful for:

•	 Seeing what actions that has been done on the project.

Functions:

•	 The upper table shows changes not yet saved.

•	 The lower table shows changes that has been saved.
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Part 5: Troubleshooting

16. Troubleshooting
This chapter includes a trouble shooting guide, describing QC issues, affected level (sample, block, plate) 
and possible root causes for some potential non-expected results. Reruns are not recommended except for 
the projects that have failed to pass formal QC. Please contact support@olink.com for further investigations 
and receiving appropriate guidance for any of these cases.

QC issue Affected  
samples/blocks/Sample plates

Possible cause 

Plate Controls and/or samples fail

Failed Plate Controls:

Deviation from reference values (±)

Multiple blocks (1-4 or 5-8) 

Both sample plates plates 

	– Dilution plates or Sample Plate 
swapped positions on Mosquito 

	– Wrong dilution protocol was used

Plate Controls fail:

Deviation from reference values

(Inc & Ext -, AMP +)

(Inc, Ext & AMP -)

Multi blocks in both Sample plates Poor PCR enzyme efficiency due 
to not adding enough Enzyme A or 
Enzyme B

Plate Controls fail:

Deviation from reference values 

(Inc -, Amp & Ext +)
	– Low counts for Incubation Controls 
	– Low counts for assays
	– High counts for Amplification and External 
Controls 

The same single block in both Sample 
Plates (e.g. Block 2 in SP1 and SP2)

1A: Forward probe was not added to 
the incubation reagent mix

1B: Not enough incubation solution 
was added while preparing the 
reagent mix

The same two blocks in both Sample 
Plates (e.g. Blocks 2 and 5 in SP1 and 
SP2)

2A: Forward probes were mixed up 
for the two blocks when preparing 
incubation mix (wrong pair of probes)

2B: Not enough incubation solution 
was added while preparing the 
reagent mix

Samples and/or external Controls fail:

Too low counts

1. One or multi samples in a block

One or both Sample Plates.

1. Incubation reagents mix or index 
not added properly due to Mosquito 
pipetting error

2. All or multi samples in multi blocks 

(Likely blocks 1-4)

Both Sample Plates.

2. Poor sequencing if %PF is low

Samples and Plate Controls fail:

Too low counts
	– Low counts for assays
	– Low counts for all internal controls

1. One same block in both Sample 
plates (e.g. Block 2 in SP1 and SP2)

1. Reverse probe was not added into 
incubation reagent mix

2. The same two blocks in both 
Sample plates (e.g. Blocks 2 and 5 in 
SP1 and SP2)

2. Reverse probes were mixed up 
for the two blocks when preparing 
incubation mix (wrong pair of 
probes). Amplification Control might 
have some counts.
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Negative Control fail

Negative Controls fail 

(Plate Controls might fail too)

1. Multi blocks in one Sample Plate 

(likely blocks 5-8)

1A. The plate layout does not match 
with the uploaded run.

1B. NCs related to one of the Sample 
Plates were pipette into wrong wells 
on Sample Source Plates.

1C. Negative Controls are 
contaminated

2. The same multi blocks in both 
Sample Plates (blocks 1-4 or 5-8)

2A. Sample Source Plates was rotated 
in the workflow

2B. Samples added instead of 
Negative Controls in Sample Source 
Plates

2C. Index plate A and B were swapped 
positions on mosquito between the 
two stages of adding indexes

2D. Negative Controls are 
contaminated

Systematic effect

Alternating column effect:

NPX value deviates in every other column 

One or multiple blocks in one or both 
Sample Plates

Mosquito pipetting error while 
dispensing reagent mix into 
incubation plate

Every 4 columns effect:

NPX values deviate between every 4 columns 

Two blocks in both Sample Plates 	– Dragonfly faulty syringe during 
dispensation of PCR mix

	– Not well vortex of PCR mix

Row effect:

NPX values deviate between samples in one 
row and samples in all other rows 

Same row in the same block in both 
Sample Plate

	– EpMotion pipetting error when 
pooling the samples 

	– Human error missing one well 
during pooling step 

NPX™ Map 
Part 5: Troubleshooting 

16. Troubleshooting



61

Gradient patterns 
(row/column/diagonal wised):

NPX Values deviate gradually in samples 
across the plate in row, column, or diagonal 
pattern 

One or multi blocks in both Sample 
Plates

	– Not well vortex of reagent mix/
plates

	– Not well adjusted/calibrated 
instruments 

NPX™ Map 
Part 5: Troubleshooting 
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17. Revision history
Version Software 

version
Date Description

1.3.0 1.3.0 2025-06-16 Added Section 10.1.2 Process Ultima data.

Added new functions in Section 10. Operating workflow, and Section 
14. General.

1.1.3 1.1.3 2025-04-09 Added Section 10.6.1 Download a Plate Layout Template file. 
Updated information in Section 14.4 Shortcuts. 
Added new functions in Section 15.2 Run Unit Details. 
Updated information in Section 15.3 Quality Control Summary.

1.1.0 1.1.0 2025-02-24 Updated table with Block QC for Reveal in Section 8. QC criteria.

Added Section 14.4 Shortcuts.

1.0.2 1.0.2 2025-02-10 Updated Section 7.1.3 Assay QC.

Updated Assay QC in the table in Section 8. QC criteria.

1.0.1 1.0.1 2025-01-27 New
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